
Microsoft has added a new feature to help users co-author files.  
Whether you are for or against this feature is not my point here: it needs 
Excel's AutoSave switched on to work.  That's fine.  But it shouldn't be 
the default.  It is accepted that Office is trying to make various apps 
consistent, but Excel is used differently.  What makes it the most popular 
software in the world is the ability to experiment without consequences. 

Made a mistake?  No fear, close without saving and re-open.  Accidentally 
delete a sheet?  Don't worry, close without saving and re-open.  Replaced 
all formulae with =RAND()? Etc etc.

For those working in the Cloud, yes you can restore earlier versions - 
when it works.  But many don't.  And some can't (no internet, company 
policies, etc.). 

What does the new setting mean?  Make a mistake?  You're stuffed.   Fed 
up of re-doing files?  Tough.  Where is my earlier version of Excel?  I will 
go back to it and to heck with Office 365.   Yes, AutoSave as the default 
is going to hurt people.  Including Microsoft's strategies to adopt O365.

It's not often we take action.  We are pretty apathetic here apparently 
(...).  But this is really going to hurt.  So we have put a request up on Excel 
User Voice at https://excel.uservoice.com/forums/304921-excel-for-
windows-desktop-application/suggestions/19333819-autosave-master-
switch-rather-than-an-i-told-you.  Please vote for this.  All we want is a 
master switch where the default setting for AutoSave is off, so if things 
go wrong, you only have yourselves to blame.   It's not asking too much, 
is it..? 

NEWSLETTER #55 - June 2017

A little controversy this month… Things are heating up with AutoSave 
changing its behaviour in Office 365 and Power BI being restructured in the data analysis and reporting world.  There’s good news and 
bad news – and we hope with AutoSave at least, you’ll want to get involved.

Regular features Power Query Pointers and Keyboard Shortcuts continue, we’ve information on various May updates  
and if you haven’t heard of our A to Z of Excel Functions, where have you BIN?    

Until next month.

We Need Your Help to Help You
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Liam Bastick, Managing Director, SumProduct

Yup, typo comes free of charge: Liam decided to half shout…
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So there’s five of them now: Power Bi Desktop, Power BI Free, Power BI Pro, Power BI Premium and Power BI Embedded.  Confused?  
It’s understandable.  Since July 2015 (when Power BI was first made generally available), Microsoft claims to have been trying to enable 
users across roles, disciplines and industries to sign up for the service in seconds and get business value by drawing insights from 
their data within minutes.  They have had two online products so far: Power BI Free as an introduction and Power BI (with a monthly 
subscription) for more advanced features.  Well, it’s now been taken further.

May saw Microsoft add an additional layer of complexity: Power BI Premium and more emphasis on the term “Power BI Embedded” 
too (more on that below).  Power BI Premium builds on the existing Power BI portfolio with a capacity-based licensing model that 
increases flexibility for how users access, share and distribute content. 

The argument is that there are four different types of end users:

	 •	 Single users: The intention here is it is designed for personal use for free.  You cannot share your outputs or Analyze in Excel 	
		  anymore (which is frustrating for early adopters), but Microsoft figures if this is the case, then maybe you should pay for the 	
		  software just like other commercial software out there.  As long as this price is reasonable (currently US$10 per user per month),  
		  this will probably attract the next category.  Just to make it more palatable, you can even get a 12 month free trial of Pro presently

	 •	 Small groups / companies: In this case, we surmise that users should head for Power BI Pro.  It’s been around a while and is great  
		  for smaller entities that cannot afford large, expensive Management Information System solutions

	 •	Medium size groups / companies: This has been identified by various as where the new pricing model problem may lie.  Having  
		  many licences can be expensive, but the Premium service is not a solution as the pricing jump is too big a leap.  There’s no  
		  Goldilocks solution here presently and a large part of the market is in limbo.  To be fair, this is not caused by the changes here.  	
		  This was a problem before – it’s just it’s disappointing it’s not been addressed in this revision of Power BI structure

	 •	 Larger groups / companies: This will probably work at the top end of the user spectrum.  Here, Power BI Premium introduces a  
		  capacity-based – and cheaper – alternative as to how an entity’s users may share and distribute key reports.

In short, the intention of Power BI Premium is that it will deliver additional scalability and performance to the Power BI service.  
Benefits are envisaged to include:

	 •	 Flexibility to license by capacity:  Power BI Premium introduces expanded licensing flexibility to help organisations equip users with  
		  the appropriate level of access to the Power BI service based on their unique needs.  For example, many organisations contain users  
		  who aren’t actively creating BI content, but require the ability to consume content distributed to them.  Power BI Premium enables  
		  Power BI Pro users to publish reports broadly across the enterprise and beyond, without requiring recipients to be licensed per user

	 •	Greater scale and performance: Organisations using Power BI Premium will be able to customise performance based on the 	
		  needs of their team, department or the organisation itself

	 •	 Power BI apps: Along with licensing Power BI for enterprise deployments, Microsoft is evolving content packs into Power BI apps  
		  to improve how users may discover and explore insights at an enterprise scale.  Already available, Power BI apps offer a simplified  
		  way of deploying dashboards and reports to specific people, groups or an entire organisation

	 •	 Extending on-premises capabilities: Power BI Premium introduces the ability to maintain BI assets on-premises with Power BI  
		  Report Server, which is an on-premises server that allows the deployment and distribution of interactive Power BI reports 		
		  completely within the boundaries of the organisation’s firewall

	 •	 Embedded analytics: With Power BI Premium, Microsoft is considering how Power BI content is embedded in apps created by  
		  customers, partners and the broad developer community.  The intention is that developers interested in embedding Power BI in  
		  their apps should be encouraged to start with Power BI Desktop and move to deployment with Power BI Premium.  Having said 	
		  that, for the time being at least, existing apps built on Power BI Embedded will continue to be supported.

This all sounds great: just why can’t more of us have it at a pricing point we can afford?  Of course, not everyone wants embedded 
analytics and on-premises capabilities, but greater license flexibility would certainly be welcomed.

Getting off our soapbox, there is another aspect of the announcement.  Microsoft is also trying to simplify the distinction between 
Power BI Pro and the free service. While the free service is intended for personal use and Power BI Pro enables collaboration, functional 
differences between them have created confusion for users.  Microsoft has gone on record that it will strive to “improve the free 
service” to have the same functionality as Power BI Pro, but will limit sharing and collaboration features to only Power BI Pro users.  
Users of the free Power BI service will benefit from access to all data sources, increased workspace storage limit, and higher refresh and 
streaming rates.  These changes will be effective June 1. Power BI Desktop continues to be available for free.  Well, for now anyway…

Power BI Develops Schizophrenia
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Regular readers will be following our expenses scenario where a number of CSVs (comma separated values files) containing expenses in a similar 
format have been extracted, transformed and loaded.  Not everyone sticks to the standard format, however, as that would be far too convenient 
for data analysts!  

Let’s imagine PQ_NonStandardExpense_CSV has come in, and it is an expense csv which is not in the usual format because John has configured his 
data ready to create a graph of where his expenses go.  Convenient for him, but not so great for appending to the existing expense query:

Name			   Date	            Petrol	 Hotel	    Food	      Personal	  
John Smith	 13/05/2015              50	     150	        30	                 12	  
			   14/05/2015              10	         0	         25	                    0	

Luckily, Power Query has a button for this – in order to get this into our required column format we will need to unpivot the data. 

The first step is to open the non-standard expense CSV and click somewhere in the table in the Excel workbook.

Choose to create a new Power Query, in this case From Table.  A pop-up will appear to confirm the boundaries of the table – adjust this range if 
required.  There is also a check box to indicate whether the table has headers:

Clicking ‘OK’ allows the data to be edited in the ‘Power Query Editor’ window as shown below:

The first step for this example is to remove any unnecessary data – in this case John has added a personal expense column which is not required in 
the model.  Highlight the column and either use the ‘Remove Column’ option on the ‘HOME’ tab, or right-click and choose Remove. 

The name can then be filled down by highlighting the Name column and using the ‘Fill Down’ option on the ‘Transform’ tab.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Excel 2016) from www.sumproduct.com/
blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month we look at unpivoting.

Power Query Pointers
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Finally, the unpivot process - select any columns to be ‘unpivoted’ (holding down SHIFT) – in this example this is everything except Name and Date.   
In the ‘Any Columns’ group on the ‘Transform’ tab there is an option to ‘Unpivot Columns’ – there are two options, either unpivot the selected 
columns, or everything except the selected columns, which can save time depending on the proportion of columns that need to be unpivoted.  The 
unpivot options are also available by right-clicking any of the highlighted columns:

One click and everything is unpivoted as required!  The small changes left to do are to transform the unpivoted columns to match the other expenses 
by renaming the headings and changing the data type on the amount column to currency – these changes can be made using the ‘Any Column’ 
group on the ‘Transform’ tab or by right-clicking the selected column and selecting the appropriate action. The data is then ready to be uploaded or 
appended to an existing expenses query – which we have covered previously.

Could it be Microsoft is starting to slow down?  For May’s updates for Get & Transform (Excel 2016) / Power Query (Excel 2010 and 
2013), there's only three new updates.  Come on guys, are you really trying? 

This month, the updates focus on the following new or improved data connectivity and transformation features:

	 •	 Split Column by Delimiter: automatic detection of delimiter character
	 •	Combine Files: ability to select sample file to use
	 •	DB2 Connector: option to specify Package Collection.

Let’s take a look at each in turn.  

Split Column by Delimiter: automatic detection of delimiter character

When splitting column by delimiter inside Query Editor via Home > Split Column, Excel will automatically detect and populate the 
Delimiter field in this dialog, based on text pattern detection in the data preview rows.  You can still change the delimiter if needed, 
but this automatic detection saves a few clicks in many cases.  

May 2017 Updates for Get & Transform / Power Query add-in

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Combine Files: ability to select sample file to use

Just like the endless succession of Resident Evil films, the incremental enhancements to the Combine Files experience appear to be 
continuing forevermore.  Microsoft has stated that one of the common areas of recent feedback has been to add the ability to select a 
file from a folder to use as the sample file to select objects and specify any custom transformation steps (if needed).

They’ve listened.  With this release, Microsoft has added a new control in the file preview dialog to allow you to choose a file available 
in the selected folder.  The default selection is the first file found, but this can be easily customised by users if need be. 

DB2 Connector: option to specify Package Collection 

The DB2 connector window now includes an option to specify the package collection to connect to within a given DB2 server.  This new 
option, available under the Advanced Options section in the DB2 connector dialog, can only be used with the Microsoft IBM DB2 driver.
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The May updates affect several previously released features, add a new slicer type that lets you filter your reports down to relative dates, such as 
the last three months and there are also now report level measures for live connections to Analysis Services tabular models and Power BI service 
datasets.

Here’s the complete list of May updates:

Report view

	 •	 Relative date slicer (preview)
	 •	New table visual (preview)
	 •	Combo chart data label enhancements
	 •	More URL support in tables and matrices
	 •	Mailto links in textbox

Analytics

	 •	 Report level measures for live connections to Analysis Services tabular models & Power BI service datasets
	 •	 Two new quick measures (preview): Total for category & Rolling average
	 •	Bin by count

Data connectivity

	 •	New connector: Dynamics 365 for Customer Insights
	 •	Combine files: ability to reference “First File” as example

Query editing

	 •	 Two new transforms: Extract text before / after / between delimiters and Unpivot only selected columns.

As always, let’s take a look at each in turn…

Relative date slicer (preview)

It seems you can’t get enough slicer types.  May saw the preview of a relative date slicer, which lets you filter based on the last one or more years, 
months, weeks or days.  This makes date slicers much more powerful, as you can always filter your report to the latest data.

You can choose the ‘Relative’ option from the list of available date slicer types.

Once you select relative from the list, you will be able to specify the period to filter by. We have seven options to pick between: 

	 •	Days
	 •	Weeks
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These updates are available as part of an Office 365 subscription.  If you have Excel 2010 or Excel 2013, you can also take advantage of 
these updates by downloading the latest Power Query for Excel add-in.

You can find out more about Power Query, Power Pivot and Power BI on one of our training courses.  Visit https://www.sumproduct.
com/courses for more information and to book today.

May 2017 Updates for Power BI Desktop

•	 Weeks (Calendar)
•	 Months

•	 Months (Calendar)
•	 Years

•	 Years (Calendar)
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If you pick an option marked with (Calendar), the filter will be based on calendar periods.  For example, if you filter to 3 years, data from the last 
three years from today’s date will show. 
 

If you filter 3 years (Calendar), data from the last three completed calendar years will show.
 

 
 
 

We show the dates used for filtering under the slicer, so you always know what data you are looking at.  You can also switch to filter to this period 
or the next period:

By default, the date range includes today, but you can override this in the formatting pane for the visual:
  

This is useful if your data hasn’t refreshed today and you don’t want to include data from incomplete days.  Microsoft has also announced they are 
planning to incorporate this relative date approach into the Filter pane in a future update as well.
You can turn on this feature through File > Options and settings > Options > Preview Features > Relative date slicer.

New table visual (preview)

May also saw a preview of a new table, with many of the new features also available in the matrix preview.  This new table, just like the matrix 
preview, is its own visual so you can test it out without needing to affect any production reports.
 

This new table has the same features of the original table, with the additional features of:

	 •	 Cross-highlighting
	 •	Word wrapping
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You can turn this preview on using the same option as the matrix preview, File > Options and Settings > Options > Preview features > New table 
and matrix visuals.

Combo chart data label enhancements

There have been several data label improvements to line and column charts over the last several months, and now these have been applied to combo 
charts well.

You can now:

	 •	Change the orientation of your column labels to vertical or horizontal
	 •	Move your column labels to inside base, inside centre, outside end or inside end
	 •	Change the label density to show more or less of your line and column labels

More URL support in tables and matrices

Microsoft now supports new link types in the original and preview table and matrix:

	 •	Mailto
	 •	News
	 •	 Telnet
	 •	 FTP
	 •	 File
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If you have one of these link types in your data, and mark the column’s data category as Web URL, Power BI Desktop will open the application you 
picked when the link is clicked.  For example, if you set Outlook as your mail client, Outlook will open a new email if you click on a Mailto link.
You can also use icons instead of the entire link in your tables by using the URL icon option in the Values card of the formatting pane.

If you are using the Power BI service, the browser will handle opening the link.  In the Desktop, it will prompt you with a message confirming you 
want to continuing launching another app.

If you want to use file URLs, there are some limitations.  They will not open in the Power BI Desktop, only in web browsers.  For most browsers, you 
will need to right click on the link, copy the link address and paste the URL in a new tab.

Mailto links in textbox

The new updates also provide support for Mailto links in textboxes.  This is great if you want to give your report viewers a person or group they can 
contact if they have any questions.

Report level measures for live connections to Analysis Services tabular models & Power BI service datasets

If you are creating a live connection to a tabular Analysis Services server or a Power BI service dataset, you can now create new measures using DAX.  
These measures will not be part of the model.  However, they will behave just like measures defined in imported models, meaning you can set their 
data type and formatting, see error messages when you break the measure expression and use intellisense when editing the expressions.  Also, they 
can be used in reports published to the Power BI service and used in visuals pinned to dashboards. You create them in just the same way as you would 
for an imported model, from the New Measure button in the Ribbon or by right clicking in the field list. 

Microsoft currently only supports report measures as a live connection against Analysis Services Tabular models.  You won’t be able to create 
measures when connected to Multidimensional cubes, but this might be coming to a theatre new you soon...

Two new quick measures (preview): Total for category & Rolling average

Further to April’s release of quick measures, there’s been two new additional calculations added to the pot: Total for category and Rolling average.

Total for category will calculate a total across all the values in a category.  There are two options for Total for category, one that will respect filters 
applied in the report and one that will ignore the filters.  Both can be found under the Totals section.
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These are useful building blocks for creating measures that calculate the contribution to a total amount or percentage of parent.

Rolling average will perform an average of the measure chosen across the given number of periods.  It can be found under the Time Intelligence 
section.

Microsoft has also added made some general improvements to the quick measures feature.  Firstly, for some quick measures you can now pick if 
blanks should be treated as zeros or be blank in the calculation.
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This is important when visuals use an attribute where the measure doesn’t have a value.  For example, if your date dimension extends further than 
the data, you might want your quick measure to return blanks when the base value is also blank.

Secondly, quick measures will now match the formatting of the base measure if the chosen measure doesn’t need a specific formatting.  For example, 
doing a year to date on a currency column will preserve the currency formatting from the base measure.  This should save you some time when 
creating new measures.

Bin by count

When creating bins, you can now decide how many bins you want, and the software will determine the correct size for the bins.  Improvements have 
been made to the binning dialog in general.  When creating bins, Power BI shows the minimum and maximum values of the source column and the 
bin size.  Microsoft also now recommends a number, or size, of bins to help pick the best grouping.  This is based on something known as the Rice rule:

New connector: Dynamics 365 for Customer Insights

That’s not all.  There’s a new connector that allows you to import and analyse data from your Dynamics 365 Customer Insights service.  The connector 
can be found under the Online Services category in the Get Data dialog:

where k is the suggested number of bins and n is the number of points (rows) in your data.  This logic will also ensure you won’t have more bins than 
you have data points.
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Combine files: ability to reference “First File” as example

May also saw Microsoft improve the Combine Files experience by allowing you to always reference the “first file” in a folder as the example file.  Before 
this update, you had to pick a specific file by name, which might cause errors in the future if the file is removed from the folder.

With this month’s update, you can select “First File” in the Combine Files dialog, which will ensure that the first file in the folder is used as the example, 
regardless of the specific file name.

Two new transforms: Extract text before / after / between delimiters and Unpivot only selected columns

Two new data transformations have been added to the Query editor in May too.

The first is Extract text before / after / between delimiters.  This is a common request where you are able to extract all text before, after or between 
delimiters from a Text column.  These new options have been added to the ‘Transform’ and ‘Add Column’ tabs in the ‘Query Editor’ Ribbon, under the 
“Extract” dropdown menu.

The second is Unpivot only selected columns.  This is a new transform which has been added under the ‘Unpivot Columns’ menu that allows you to 
unpivot only the currently selected columns in the Query Editor preview.  This will generate an explicit columns list in the current step so that the same 
set of columns is unpivoted on future refresh operations.

In addition to the newly added ‘Unpivot Only Selected Columns’ option, you also can apply one of the following options from the ‘Unpivot Columns’ 
menu:

	 •	Unpivot Columns: This operation will unpivot all columns except all the non-selected ones. This case is optimised for scenarios where new 	
		  columns that appear in the future need to be unpivoted as well.  For example, datasets where new columns represent data for new dates  
		  (e.g. monthly sales, weekly occurrences).
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	 •	Unpivot Other Columns: This operation provides the same capability as ‘Unpivot Columns’ in terms of future behaviour with respect to new 	
		  columns appearing in the table.  The main difference with ‘Unpivot Columns’ is that it allows you to select that columns that should not be 	
		  unpivoted.  This case optimises the user flow for cases where the number of columns that should not be unpivoted is much smaller than the 	
		  number of columns that ‘ be unpivoted, similarly to the behaviour of ‘Remove Other Columns’ compared to ‘Remove Columns’.

We imagine there will be more updates shortly!

They say there’s 10 types of Excel user: those who understand binary and those who don’t.  

This function converts a binary number (base two) to a decimal number (base 10).  The BIN2DEC function employs the following syntax to operate:

BIN2DEC(number)

The BIN2DEC function has the following arguments:

	 •	 number: this is required and represents the binary number you wish to convert to a decimal
	 •	 number cannot contain more than 10 characters (10 bits)
	 •	 the most significant bit of number is the sign bit
	 •	 the remaining nine bits are magnitude bits
	 •	 negative numbers are represented using two's-complement notation. 

Two's complement is a mathematical operation on binary numbers, as well as a binary signed number representation based on this operation.  The 
two's complement of an N-bit number is defined as the complement with respect to 2N; in other words, it is the result of subtracting the number 
from 2N.  This is also equivalent to taking the ones' complement and then adding one, since the sum of a number and its ones' complement is all 1 
bits.  The two's complement of a number behaves like the negative of the original number in most arithmetic, and positive and negative numbers 
can coexist in a natural way.

In English then, if number is 10 digits and the first number is 1, the number is deemed negative and 29 (512) is subtracted from it, e.g. 
BIN2DEC(1111111111) = -1, being 511 (111111111 as a decimal) less 512.

It should be further noted that if number is not a valid binary number, or if number contains more than 10 characters (10 bits), BIN2DEC returns the 
#NUM! error value. 

Please see consider the following example: 

The A to Z of Excel Functions: BIN2DEC

As I asked my local witch the other day where she had gone, she had told me she had BIN2HEX someone (groan… - Ed.).  Now, we don’t 
want to put the hex on this function, but this converts a binary number (base two) to a hexadecimal number (base 16).

The BIN2HEX function employs the following syntax to operate:

BIN2HEX(number, [places])

The BIN2HEX function has the following arguments:

	 •	 number: this is required and represents the binary number you wish to convert.  It should be noted that number cannot 		
		  contain more than 10 characters (10 bits) and that the most significant bit of number is the sign bit.  The remaining nine bits are  
		  magnitude bits.  Negative numbers are represented using two's complement notation
	 •	 places: this is optional and represents the number of characters to use.  If places is omitted, BIN2HEX uses the minimum 		
		  number of characters necessary.  The argument places is useful for padding the return value with leading 0s (zeros).

The A to Z of Excel Functions: BIN2HEX
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It should be further noted that: 

	 •	 If number is not a valid binary number, or if number contains more than 10 characters (10 bits), BIN2HEX returns the #NUM!  
		  error value
	 •	 If number is negative, BIN2HEX ignores places and returns a 10-character hexadecimal number
	 •	 If BIN2HEX requires more than places characters, it returns the #NUM! error value
	 •	 If places is not an integer, it is truncated
	 •	 If places is nonnumeric, BIN2HEX returns the #VALUE! error value
	 •	 If places is negative, BIN2HEX returns the #NUM! error value.

Time for another example: 

And just in case you thought the jokes were over, it’s a little-known fact that Wyclef Jean’s hit single Gone ‘Til November was not the inspiration for 
BIN2OCT.  This function actually converts a binary number (base two) to an octal number (base eight).

The BIN2OCT function employs the following syntax to operate:

BIN2OCT(number, [places])

The BIN2OCT function has the following arguments:

	 •	 number: this is required and represents the binary number you wish to convert.  It should be noted that number cannot contain more 	
		  than 10 characters (10 bits) and that the most significant bit of number is the sign bit.  The remaining nine bits are magnitude bits.  Negative 	
		  numbers are represented using two's complement notation
	 •	 places: this is optional and represents the number of characters to use.  If places is omitted, BIN2OCT uses the minimum number of characters  
		  necessary.  The argument places is useful for padding the return value with leading 0s (zeros).

Yet again, it should be further noted that: 

	 •	 If number is not a valid binary number, or if number contains more than 10 characters (10 bits), BIN2OCT returns the #NUM! error value
	 •	 If number is negative, BIN2OCT ignores places and returns a 10-character octal number
	 •	 If BIN2OCT requires more than places characters, it returns the #NUM! error value
	 •	 If places is not an integer, it is truncated
	 •	 If places is nonnumeric, BIN2OCT returns the #VALUE! error value
	 •	 If places is negative, BIN2OCT returns the #NUM! error value.

And so to our final example for this month: 

May saw the two-week tour Down Under for seven Excel MVPs, two Microsoft staff, an academic and several CPA staff come and go.

The A to Z of Excel Functions: BIN2DEC

Unlock Excel Locks Up
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Upcoming SumProduct Training Courses

Location Course Date Duration

Melbourne Introduction to Financial Forecasting 1st Jun 2017 1 day

Perth Excel Tips & Tricks 12th Jun 2017 1 day

Perth Financial Modelling 13th - 14th Jun 2017 2 days

Sydney Excel Tips & Tricks 13th Jun 2017 1 day

Sydney Financial Modelling 14th Jun 2017 1 day

Melbourne Power Pivot, Power Query and Power BI 19th - 21st Jun 2017 3 days

Brisbane Excel Tips & Tricks 26th Jun 2017 1 day

Brisbane Financial Modelling 27th - 28th Jun 2017 2 days

Melbourne Excel Tips & Tricks 3rd Jul 2017 1 day

Melbourne Financial Modelling 4th - 5th Jul 2017 2 days

Sydney Visual Basic for Applications 10th Jul 2017 1 day

Sydney Power Pivot, Power Query and Power BI 17th - 19th Jul 2017 3 days

Adelaide Power Pivot, Power Query and Power BI 24th - 26th Jul 2017 3 days

Sydney Excel Tips & Tricks 31st Jul 2017 1 day

Sydney Financial Modelling 1st - 2nd Aug 2017 2 days

Perth Power Pivot, Power Query and Power BI 7th - 9th Aug 2017 3 days

Adelaide Excel Tips & Tricks 14th Aug 2017 1 days

Adelaide Financial Modelling 15th - 16th Aug 2017 2 day

Melbourne Mergers and Acquisitions 21st - 24th Aug 2017 4 days

Brisbane Power Pivot, Power Query and Power BI 28th - 30th Aug 2017 3 days

Over the eight action-packed days, in excess of 500 Excel users listened to various topics including the perennial tricks and tips, financial modelling, 
PivotTables, Power Query, Power Pivot, Power BI, charts, dashboards and VBA.  Power Pivot, Power Query and Excel forecasting were the most 
popular topics but there was something for everyone, including the now-legendary “Top Excel Tip” which if you missed it, you should have come!  

Our picture shows from left to right, Mynda Treacy, Ingeborg Hawighorst, Microsoft's Dany Hoter, Roger Govier, Ken Puls, Chandoo, Jon Peltier and 
our own Liam Bastick.  Absent were Microsoft's Eric Patterson and modelling expert Bas Jansen, who presumably had gone shopping.

If you missed it, don't worry.  Online video sessions will be available soon and we are hoping to create a similar event in 2018 where you can come 
along in person.

If you can’t have a laugh, what can you do?  It’s not just us at SumProduct that are completely deranged working with Excel all of the time.  Perennial 
parody balladeer Clint Tuttle has come up with a little gem extolling the virtues of Excel, which has more than a passing resemblance to Ed Sheeran’s 
Shape of You.  Quite the hoot.

If you are not familiar with Clint’s work, you should check out some of his past exploits – there’s more than one Excel MVP embarrassing themselves 
on-camera (tee hee).

And Finally…
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 		
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  We’re still going through the 
function keys – this time, having looked at binary functions, the F10 function key seems somehow appropriate:

There are over 540 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file a
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Keystroke What it does

F10 Activate menus

CTRL + F10 Toggle Maximised / Restored

SHIFT + F10 Activate context menus (right-click equivalent)

SHIFT + ALT + F10 Show On-Object User Interface (OOUI)

Have you heard about the 
SumProduct Referral programme? 
If you successfully introduce us to a 
client we will pay you 10% of the net 
profits of the engagement won upon 
receipt of client payment. Sounds like 
a pretty good deal to us!

Terms and conditions apply.  Referrer 
must be over 18 years of age, able 
to issue an invoice and not be an 
employee, director, agent or other 
related party of the client engaged.  
For further information, drop us a line 
at  contact@sumproduct.com.  We 
hope to hear from you!

Referral Programme

Melbourne Excel Tips & Tricks 4th Sep 2017 1 day

Melbourne Financial Modelling 5th - 6th Sep 2017 2 days

Melbourne Power Pivot, Power Query and Power BI 12th - 14th Sep 2017 3 days

Sydney Excel Tips & Tricks 25th Sep 2017 1 day

Sydney Financial Modelling 26th - 27th Sep 2017 2 days

Sydney Power Pivot, Power Query and Power BI 16th - 18th Oct 2017 3 days

Melbourne Excel Tips & Tricks 23rd Oct 2017 1 day

Melbourne Financial Modelling 24th - 25th Oct 2017 2 days

Sydney Visual Basic for Applications 6th Nov 2017 1 day

Sydney Excel Tips & Tricks 13th Nov 2017 1 day

Sydney Financial Modelling 14th - 15th Nov 2017 2 days

Melbourne Power Pivot, Power Query and Power BI 4th - 6th Dec 2017 3 days

Melbourne Excel Tips & Tricks 11th Dec 2017 1 day

Melbourne Financial Modelling 12th - 13th Dec 2017 2 days
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